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How to read each Feature Summary?

New Feature 

Introduced in latest 
release by Oracle

Short Description of 

the New Feature

Business Benefits 

realized from the 
New Feature

Mastek Feature 

Analysis for Your 
Business Mastek Impact Study on 

Potential Impact to 
users for using new 
feature

LOW: No large scale 
impact. Regression 

testing can be ignored.
HIGH: Needs to be part 
of the regression 

testing.

YES: Configuration set 

up needed to use new 
feature.
NO: User can use the 

feature by default with 
no change needed.

NO : Already enabled 

and ready to use with 
some or no 
configuration

YES: Need to opt-in to 
use the feature.

YES: Need minimal time of both 

parties to make use of the 

feature. 

NO : Need significant amount of 

time and effort to make use of 

the feature.
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NEW FEATURES

OUR ANALYSIS OF LATEST RELEASE



QUICK WINS – DEFAULT WITH NO 
CONFIGURATION

NEW FEATURE – GLOBAL PAYROLL
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DELETION OF TIME AFTER TERMINATION DATE OF 
EMPLOYEE

Details

When an employee is terminated, all time entries held in the Payroll application that are dated after
the employee's termination date, are now automatically deleted. For example, when an employee is
terminated on 15/07/24, all time entries held in Payroll for 16/07/24 or a later date,

are automatically deleted. So, a HR user can now terminate an employee on 15/07/24, and Payroll
won't display any error message to stop the termination transaction, even if the employee has time

entries beyond 15/07/24.

Payroll application deletes the time loaded from both HCM Data Loader (HDL) and Time and Labor 

application.

• Payroll application deletes the time as soon as the termination transaction is entered in the 
application.

• Time and Labor application deletes the time only after the termination date has passed.

HR users and line managers now don't need to manually delete the time entries that exist after the 
employee's termination date, nor run a script to delete these time entries.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

Eliminates the need to delete

future time entries, preventing

users from being unable to perform

termination actions.

Business Benefit:
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REDWOOD PAYSLIP ENHANCEMENTS

Details

• On the Payslip page, when you download one or more payslips using the Export icon, you can select
the folder to save these payslips, and download them in a compressed (zip) file. This feature lets you
to utilize less storage space and transfer the payslips to other devices easily.

Using extensibility, you can also do the following:

• Hide the Export icon, if your company doesn't need the ability to download multiple payslips.

• Reorder the tabs on the page. For example, you can select to display the Payslip Preview page first, 
followed by the Earnings, Deductions, and Net Pay Distribution pages.

• This feature lets you configure the Payslips page according to your business requirement.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

Allows professional users to

download multiple payslip and

provides flexibility to reorder tabs of

payslip page

Business Benefit:
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VIEW YEAR END DOCUMENTS

Details

View all year-end documents for an employee on the Year-End Documents page. This page displays all 
documents that have a publish date that's the same as, or earlier than today's date. You can also search 

for a document using the Specific Date Range search option. This search option returns all documents with 
an end date that falls within the start date and end date of the search period.

• Let's take an example of a year-end document, such as a W4, which has the following dates:
o Start Date: 01-JAN-24, End Date: 31-DEC-24 and Publish Date: 14-FEB-24

o When you view the page on 07-APR-24, the document is displayed because the publish date of 

the document falls before the session (current) date. 

• In the View drop-down list, the option All is selected by default. 

Impact Level Low

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

Allows users to view all published

documents as of the current date,

improving the user experience.

Business Benefit:
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ADDITIONAL INFORMATION IN COSTING RESULTS UI AND 
COSTING RESULTS REPORTS

Details
You can now view the status of the Transfer to Subledger Accounting process and the status of the Import Payroll
Costs process for each payroll costing result. Following attributes are added to Costing Pages and reports

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

Additional fields and parameters

allow users to view more details

and report accurately.

Business Benefit:

• The following new parameters have also been added to the detail and the summary versions of the Costing Results Report.
• You can select the relevant parameters when you submit the Costing Results Report, You can also display the new attributes on the Costing 

Results UI by selecting the check box against each attribute using View -> Columns navigation.

Attribute Costing Results Page Costing Results Detail Report
Costing of Payment Results 

Page

Subledger Event Details Yes Yes Yes
Transfer to Project Status Yes Yes Yes
Cost Identifier Yes Yes No
Source Identifier Yes Yes No

Parameter Name Value

Show SLA and 
Project Transfer 
Status

Blank value (no value 
selected)

Not transferred

Unprocessed

Draft

Final

Invalid

Incomplete

Parameter Name Value

Projects Transfer 
Status

Blank value (no value selected)

Not transferred

Transferred to Projects

Processed in Projects

Reversed in Projects

Ignored in Projects

Parameter Name Value

SLA Transfer Status

Blank value (no value 
selected)

Not transferred

Unprocessed

Draft

Final

Invalid

Incomplete
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ISO 20022: GLOBAL PAYMENTS XML SUPPORT

Details

You can use the global payments XML file that now supports additional attribute requirements around 
ISO 20022, a global XML standard used by financial institutions for electronic payment messages. You 

can build or update your country-specific electronic payments messages templates using this 
enhanced global payments XML that consolidates all the information relating to electronic payments.

The global payments XML now includes these new attributes:

• Requested Execution Date

• Business Identifier Code (BIC) for the financial institution

• Structured Creditor and Debtor address for third-party persons, third-party organizations, and 

person

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

Allows business to manage country

specific electronic messages.

Business Benefit:
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CATEGORY CODE IN PAYROLL SUBJECT AREA

Details
The new attribute "Category Code“ is added under the Element folder in the following subject Areas.

• Payroll - Element Entries Real Time
• Payroll - Element Entries History Real Time

• Payroll - Payroll Run Costing Real Time
• Payroll - Payroll Run Results Real Time

• Payroll - Retroactive Pay Real Time
• Compensation - Individual Compensation Real Time

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Global Payroll

This enhancement lets you

report payroll information

with category code field.

Business Benefit:



QUICK WINS – DEFAULT WITH 
CONFIGURATION CHANGE

NEW FEATURE – GLOBAL PAYROLL
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REDWOOD EXPERIENCE FOR PERSON MESSAGES

Details
You can access the Redwood Messages page using any of the following navigation:

• Use the Person Results task to directly search for an employee and use the Actions menu to open the 
Messages page for the employee.

• Click on a person name while viewing records processed in a flow to go to the Results page and click on 

the Messages tab.

• The redesigned results pages for a person are available when you enable both profile options:

ORA_HCM_VBCS_PWA_ENABLED and ORA_PAY_PROCESS_RESULT_PAGES_FOR_PERSON_REDWOOD_ENABLED

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global Payroll

The new page offers a fewer 

number of clicks and better 

performance. You can take 

advantage of the cohesiveness 

through the application with the 

new page.

Business Benefit:
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REDWOOD EXPERIENCE FOR PAYMENT RESULTS

Details

You can access the Payment Results page by using navigations such as:

• Use the Person Results task to directly search for an employee and view the Prepayment or Payment Results, for 

example, Generate Check Payment, rollback, void a paid payment, record external payment information against 

unpaid/voided prepayment record.

• Use the Process Results Summary task to search and select the flow you've submitted, (for example, Calculate 

Prepayment Flow), and view individual records processed by the flow. Use the Actions menu on an individual record to 

open the Payment Results page of the employee.

• The redesigned results pages for a payment results are available when you enable both profile options: 
ORA_HCM_VBCS_PWA_ENABLED and ORA_PAY_PROCESS_RESULT_PAGES_FOR_PERSON_REDWOOD_ENABLED

The Payment Results page is viewed in the context of an employee and a process. Use the Process field at the top of the 

page to view the prepayments and payments processes run for the employee.

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global Payroll

The new page offers a fewer 

number of clicks and better 

performance. You can take 

advantage of the cohesiveness 

through the application with the 

new page.

Business Benefit:
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REDWOOD EXPERIENCE FOR PERSONAL PAYMENT 
METHODS : VIEW CORRECTIONS

Details:

You can now view all the corrections made to a personal payment method in the Redwood Summary

of Changes page available to the professional users. The history section on the Personal Payment
Method page lists all the effective-dated updates to the personal payment method since it was
created. When you have auditing on personal payment methods enabled, you can drill down into an

effective-dated personal payment method record to view all the corrections made to that record in
the Summary of Changes page.

Steps to Enable : This feature is not available by default, and you must configure the audit policies of Global Payroll

product for personal payment methods table with required attributes.

Navigate to My Client Groups>Payroll>Personal Payment Methods>Drill down into any payment method >

View History > Drill down into any of the effective-dated update records

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global PayrollGlobal Payroll

Business Benefit:

A professional user can view

historical changes to employees'

personal payment methods on

the same screen.
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DISTRIBUTED ELEMENT NAME AS SUBLEDGER 
ACCOUNTING SOURCE

Details

• You can now view the name of the distributed element in the results for the subledger accounting 
process. When the costs for an element is distributed, the name of the distributed element is now 

displayed on the journal line, such as the name of the employer costs element is now displayed on the 
salary cost result.

• View the name of the distributed element in the subledger accounting process results.

• Steps to Enable
• To display the name of the distributed costs element in the subledger journal lines, you need to create 

a description rule with the Distributed Costs Element Name as the source and attach this new rule to 
the Subledger Journal Entry Rule sets.

Impact Level Low

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global Payroll

Provides more information to the

professional user while validating

journal entries.

Business Benefit:
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AUDIT ELEMENT SECURITY PROFILES

Details

• You can enable auditing for element security profiles and their associated attributes. You can also view 
audit reports using the audit report functionality.

• Follow below steps to enable auditing for element security profiles

o Search for and use the Manage Audit Policies task from Setup and Maintenance.
o On the Manage Audit Policies page, select Auditing as the Audit Level for Oracle Fusion 

Applications. This setting turns on the auditing functionality.

o Click Configure Business Object Attributes.
o On the Configure Business Object Attributes page, select Global Payroll as the Product. The 

business objects associated with that product appear in the Objects section.
o Select the check boxes for the Element Security Profile and its attributes Legislative Data 

Group, Element, and Element Classification.

o Click Save and Close.

• When an element is removed from the Element Security Profile, it is tracked in the Audit Report. 
However, when an element that is included in a security profile is deleted from the Manage Element 
page, it is automatically removed from the security profile. This deletion isn't shown in the Audit 

Report.

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global Payroll

The element security object is

supported by the audit

framework, allowing users to

view changed information.

Business Benefit:
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ABSENCE DONATION PLAN

Details

• You can create absence accrual elements and enable them for donating to donation pools. When 

an employee donates leave from an accrual-based absence plan to a donation pool, the plan's 
element processes the donation in the payroll run, where it calculates the monetary value of the 

donations, and transfers that value to the nominated donation pool.

• You can create donation pool absence elements that are associated with a donation pool absence 

plan. When an employee's claim from a donation pool is approved in Absences, the donation pool 
element processes the claim in the payroll run, where it calculates the monetary value of the 

claims, and transfers that value out of the nominated donation pool.

Impact Level HIGH

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win NO

Global Payroll

Allows organization to configure 

Donation plan and process 

payments as per business rules.

Business Benefit:
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REDWOOD EXPERIENCE FOR FLOW SUBMISSION

Details

You can now submit a flow, data load, or report using Submit a Flow page.

• Navigate to My Client Groups>Quick Actions>Submit a Flow

• It will allow you to submit a flow by selecting LDG , flexibility to schedule a flow, view recently submitted flows using 

search option.

• Provides flexibility to user to view all required and optional parameters which are grouped together for quicker 

submission.

• Allows user to link flow using Linked Flow tab. 

• The redesigned Submit a Flow page are available when you enable profile options: ORA_HCM_VBCS_PWA_ENABLED, 

ORA_PAY_SUBMIT_FLOWS_REDWOOD_ENABLED and ORA_PAY_DE_SUBMIT_FLOWS_REDWOOD_ENABLED

Impact Level HIGH

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Global Payroll

The new page offers a fewer 

number of clicks and better 

performance. You can take 

advantage of the cohesiveness 

through the application with the 

new page.

Business Benefit:
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BALANCE EXCEPTION REPORT ENHANCEMENT

Details

• You can now track balance exceptions for a specific payroll run. This enhancement ensures run 
dimension support on balance exceptions allowing you to define exceptions based on a balance 

value for a run.

• Balance Exception Report supports flow connector rules. For example, during a payroll period, you 

run several off-cycle QuickPay runs to accommodate ad-hoc late or bonus payments to your 
employees or payment settlements for terminated employees. You also run the usual on-cycle 

payroll runs for the same payroll period.

• For example, use these values to define an exception to track employees with salary greater than 

$2,000 in the current run.
o Comparison Type: Current Run

o Dimension: Relationship Tax Unit Run

• To support this exception rule you must define the following:
o Balance Name: e.g. Salary

o Variance Type: Amount

o Variance Operator: Greater Than

o Variance Value: 2,000

o Severity: 1

• When you run the Balance Exception Report, the generated report shows employees having 
salaries greater than $2000 for the current run only.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration YES

Quick Win YES

Global Payroll

Additional support with run

dimension to manage exception

reporting.

Business Benefit:



QUICK WINS – DEFAULT WITH NO 
CONFIGURATION 

NEW FEATURE – ABSENCE 
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CAPTURE PLAN AND TYPE SETUP CHANGE HISTORY

Details

➢ You can now track changes to absence plans and absence types by enabling auditing for them.The

following base tables can be audited for absence plans:
➢ anc_abs_agreement_plans_f

➢ anc_plan_elig_profiles_f
➢ anc_entl_bands_f
➢ anc_entl_bands_dtl_f

➢ anc_accrual_bands_f
➢ anc_absence_plans_f

➢ anc_plan_events_f

➢ Similarly, the following base tables can be audited for absence types:

➢ anc_absence_types_f
➢ anc_absence_type_reasons_f

➢ anc_absence_type_regions_f
➢ anc_absence_type_plans_f
➢ anc_abs_type_rgn_usages_f

➢ anc_abs_type_certs_f
➢ anc_type_events

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

In this feature you can now track 

setup changes to absence plans and 

absence types by enabling auditing.

Business Benefit:
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APPROVAL COMMENTS ENTRY ON ABSENCE PLANNING

Details

• Managers can now enter a comment when approving or rejecting a single or multiple absence requests
from the Absence Planning Redwood page. The approver comment is passed to the BPM Approval Tasks

for the newly created and submitted absences, and are seen in the notification sent to the approver.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

Line managers can now enter a 

comment when approving or 

rejecting a single or multiple 

absence requests from the 

Absence Planning page

Business Benefit:
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ENHANCED HALF-DAY ABSENCE OPTION

Details

• The ability to specify which half of the shift a worker won't work during a half day absence has been
enhanced further. You can now use the half day option to specify the shift for the following:

➢ Repeating absences
➢ Absence bids

➢ Absence entry by an administrator
Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

This Feature allow ability to select 

which half of the shift a worker 

won't work during a half day 

absence

Business Benefit:



Presentation Title  |  Author  |  Date 26Company Confidential © Mastek 2023. All rights reserved  |

REDWOOD UI SUPPORT FOR ADDITIONAL FEATURES

Details

• The Redwood absence entry page has been further enhanced to now support the following features:
You can now display multiple warning messages in the Redwood pages for absence entry and

absence bid entry.
You can display multiple warning messages when approving absences in the Absence Planning

Redwood page.
• There are 3 types of warnings that can appear on these pages. They are as follows:

➢ Warnings from validation fast formula

➢ Concurrent absence warning
➢ Low balance warning

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

The Redwood absence pages can 

now display multiple warning 

messages at once, thus improving 

the ease of use.

Business Benefit:
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EVALUATE IN-PROGRESS OPEN ENDED ABSENCES

Details

• You can now include in-progress open ended absences when evaluating all in progress and future
dated absences using the Evaluate Absences process. There is a new parameter in the process

called Include in progress open ended absence. You get this check box only when you select
the Evaluate All Absences option in Record Selection.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

This Feature allow to include in-

progress open ended absences 

when evaluating all in progress 

and future dated absences.

Business Benefit:
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SCHEDULED SHIFT BREAKDOWN AVAILABLE FOR ALL 
UOMS

Details

• If you enable the new Time-Absence integration, then the application creates absence shifts data for
all UOMs. For every absence, shift breakdown data is written in the following tables:

➢ anc_per_abs_shift_breakdown
➢ anc_per_abs_shift_calc_ent

• This shift data is useful for time integration and for scheduling engine.
Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Absence

This Feature allow shift data for 

all UOMs which is useful for time 

integration and for scheduling 

engine

Business Benefit:



QUICK WINS – DEFAULT WITH 
CONFIGURATION CHANGE

NEW FEATURE – ABSENCE 
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REDWOOD EXPERIENCE FOR ABSENCES REGION IN 
GLOBAL TRANSFER

Details

• The absences region in the local and global transfer page was re-created using the Redwood tool 
set available in Oracle Visual Builder Studio to improve the user experience by providing the same 
consistent functionality across Redwood pages. Profile option -

ORA_PER_EMPL_LGT_REDWOOD_ENABLED

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration NO

Quick Win YES

Absence

The new Redwood absences 

region in the local and global 

transfer page lets 

users experience Redwood’s 

high-fidelity interactions

Business Benefit:
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DONATION POOLS

Details

• You can now configure an absence plan of the Donation plan type as a donation pool plan. 

Employees can donate accrued hours or days to the pool which are maintained as monetary fund 
by the payroll. When the employees require additional PTO hours, they can request for more 

hours from this pool. 
• Their claim must be approved by an HR Administrator, who then manually enrolls the employee 

into the donation pool plan and transfers the approved hours or days into their enrollment.

• If the worker loses eligibility or doesn’t consume the donated hours in the period specified by 
company policy, the HR administrator can manually return the remaining balance from worker's 

pool plan enrollment back into the donation pool fund. To do so, click Enrollments and 
Adjustments > Return Balance to Pool.

Impact Level HIGH

Impact Analysis

Need to Enable NO

Configuration YES

Quick Win NO

Absence

Using this feature workers can now 

donate balances to a donation pool 

plan which is managed as a 

monetary fund by payroll, and 

request for more hours from the 

same pool.

Business Benefit:



QUICK WINS – DEFAULT WITH NO 
CONFIGURATION 

NEW FEATURE – TIME AND LABOR 
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NEW DATABASE ITEMS FOR THE WORKFORCE 
SCHEDULING INTEGRATION

Details

• New database items are delivered to get the incentive amounts and overtime allowed 

attribute values for workforce scheduling shifts in time rules.

• These enhancements let you validate time-card information and calculate time entries using 
these attributes for workers' workforce scheduling shifts.

KEY RESOURCES

For a complete list of Workforce Management database items, including the new items for 
Workforce Scheduling integration, see the Workforce Management (WFM) Database Items 
spreadsheet attachment for Time and Labor Fast Formula References (Doc ID 1990057.1) on My 

Oracle Support.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Time and Labor

This feature enhances various

ways towards validating time-card

information with workforce

scheduling integration in time and

labor module.

Business Benefit:
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TIME CARD ADDITIONAL STATUSES ON THE REDWOOD 
TEAM TIME CARDS PAGE

Details
1. You can now review the processing and transfer statuses for a time card and its entries by time 

consumer, such as payroll and project costing, from the Redwood Team Time Cards page.
2. Additional statuses display in a dedicated drawer opened using the row-level icon in the Additional 

Statuses column.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Time and Labor

This enhancement aligns Redwood

team time cards with classic time

card functionality.

Business Benefit:
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TIME CARD DELETION FROM THE REDWOOD EXISTING 
TIME CARDS PAGE

Details

1. If your worker time entry profile allows it, you can now delete unaudited time cards and time cards 

with no pending change requests. Use the row-level action on your Existing Time Cards page.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Time and Labor

This enhancement aligns

enhanced time cards with classic

and responsive time card

functionality.

Business Benefit:
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DEFAULT ON-CALL ENHANCEMENT

Details

1. You can now apply previously delivered defaulting of Workforce Scheduling on-call shifts with 

assigned workday definitions. Workday definition rules now apportion the on-call shift to the correct 
days. The parts of the shifts that aren't in the current time card period are now applied when the 

next time card period is created.
2. For example, a worker is assigned the 9:00 PM - 9:00 AM on-call shift for Saturday and Sunday. Their 

work day definition is to split entries at day start time, which is 4:00 AM. The time card will show an 

escape day at the end of the Monday to Sunday time card period, and split the Sunday entry at 4:00 
am. The current time card will have an entry for the 9:00 PM to 4:00 AM portion of the on-call shift. 

The 4:00 AM to 9:00 AM portion will be on the time card for the next time card period. You don't see 
in on the escape day because the time card period ends at the day start time, 4:00 AM.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Time and Labor

This enhancement aligns time

cards and workday definitions to

correctly default on-call shifts as

time card entries according to

your time and labor policies.

Business Benefit:
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TIME CARD ENHANCEMENT

Details

1. You can now save a Redwood time card as a named template. You can apply the template to your 

Redwood time cards with the same assignment ID and layout set ID as the template.
2. Currently, you can save up to 6 templates. After that, you get a warning and need to overwrite an 

existing template or cancel the template.

Impact Level LOW

Impact Analysis

Need to Enable NO

Configuration NO

Quick Win YES

Time and Labor

This feature helps workers

streamline their time entry

process. worker overwrite existing

templates so that the application

Business Benefit:

•As soon as you have at least 1 template, you'll see the Apply Template action above the time card grid. 

When you apply a template, it's appended to the time card starting at the next blank row. Templates 
won't overwrite any existing entries on the time card. Because templates are appended, you can apply 
multiple templates to a single time card.

•You can always clear any changes to the time card since the most recent save by clicking the Clear 
Time Card icon.



QUICK WINS – DEFAULT WITH 
CONFIGURATION CHANGE

NEW FEATURE – TIME AND LABOR 
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EMPLOYEE CALENDAR INTEGRATION

Details

• When ICS file inclusion is enabled, workers will get an ICS file with their schedule details

whenever a new schedule is published.
• They can import the file into their personal calendars so that all of their schedule information is

easily accessible and up to date.
• Workers will also get an updated ICS file whenever their schedules change. Changes include

approved shift drops, cover requests, and swaps. They also include newly assigned shifts,

unassigned shifts, and updated details for assigned shifts.
• This feature empowers workers to effortlessly sync their work schedules with their preferred

calendars , improving convenience and ensuring that all schedule-related information is easily
accessible and up to date.

• STEPS TO ENABLE

• In the Setup and Maintenance work area, on the Tasks panel tab, click Search.
• On the search page, search for and select the Manage Administrator Profile Values task.
• On Manage Administrator Profile Values page, search for the ORA_HTS_INCLUDE_ICS_FILE profile

option code.
• In the Site level row, select Yes.

• You need to schedule the Process Workforce Scheduling Alerts process to run for these alerts to
be sent out. Schedule the process using Tools > Scheduled Processes.

Impact Level MEDIUM

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Time and Labor

This syncing helps reduce

miscommunication, enhances

productivity, and supports

better time management

within the organization.

Business Benefit:
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REDWOOD TIME CARD ENHANCEMENTS

Details

Row level comments
• You can now enter a comment that applies to each entry in a row by right-clicking the row 

number.
• A comment added at a row level is stored against each entry of the row and identified with a blue 

triangle icon in the quantity fields. You can review and edit row-level comments on each entry and 
in the Comments drawer.

Sort the grid time entries
• You can now sort time entries in ascending or descending order using any of the grid columns. An 

arrow icon appears when you hover over the column header to show you the available sort 
direction.

Display scheduled hours
• Depending on your shift types and time card setup, you can now see a header row between the 

period days and attributes that shows your scheduled times and hours, or scheduled hours for each 

day.

Resize grid columns and rows
• You can now resize grid columns and rows. And this resizing remains if you reopen the time card 

using the same device.

• These enhancements provide a better experience with enhanced time cards.

Impact Level MEDIUM

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Time and Labor

These enhancements provide a

better experience with enhanced

time cards.

Business Benefit:
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ROLLING PERIOD FILTER ON THE REDWOOD TEAM TIME 
CARDS PAGE

Details

1. You can now filter time cards based on a relative period. A new Relative Range filter has a list of 

periods enabled from the setup.
2. The default saved search still shows you all time cards for the previous 2 weeks. The start and end 

dates of the Dated Range (previously named Time Period) filter chip reflect this relative period.

STEPS TO ENABLE

1. In the Setup and Maintenance work area,

on the Tasks panel tab, click Search.
2. On the search page, search for and
click the Manage Common Lookups task.

3. On the Manage Common Lookups pages,
search for the ORA_HXT_RELATIVE_RANGES lookup.

4. Enable the lookup codes that you
want to show for the Relative Ranges filter chip 
on the Team Time Cards page.

Impact Level LOW

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win YES

Time and Labor

This enhancement gives line

managers and time and labor

managers another way to quickly

filter results to show only the

relevant time cards.

Business Benefit:
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TIME CARD APPROVAL ENHANCEMENT

Details

1. You can view approval comments for each completed Redwood time card approval task only from 

either the Bell icon in the top-right area of the app or the email notification. Your worklist 
notification won't include the approval comments.

2. If the submitted time card contains both project costing and payroll data and both approval tasks are 
configured to complete, you'll need to view the approval comments from both completed tasks. Impact Level HIGH

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win NO

Time and Labor

This enhancement aligns

enhanced time cards with classic

and responsive time card

functionality.

Business Benefit:

Steps to Enable
• In the Setup and Maintenance work 

area, on the Tasks panel tab, 

click Search.
• On the search page, search for and 

click the Manage Task 
Configurations for Human Capital 
Management task.

• On the BPM Worklist page, make 
sure Task Configuration is selected.

• In the Search field, enter
Time

Other BPM related steps are 
mentioned in Test Script



NEW FEATURE – WORKFORCE 
SCHEDULING

QUICK WINS – DEFAULT WITH 
NO CONFIGURATION
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ADDITIONAL SHIFTS ATTRIBUTES

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

The additional attributes on 

scheduled shifts help you 

respond more efficiently to the 

scheduling gap by authorising

overtime and encouraging work 

on specific critical shifts.

Business Benefit:

You can now let workers exceed their FTE when they work shifts marked as overtime allowed. There won't

be any validation warnings. Also schedule managers can encourage workers to work certain shifts by offering
them incentives.
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GENERATE AND VALIDATE WORKFORCE SCHEDULE 
ENHANCEMENT

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

This enhancement ensures that workforce 

schedules comply with organizational policies 

and regulatory requirements.

Business Benefit:

• When the generate schedule process runs, it matches worker workloads according to their work

patterns and weekly FTE hours. It also applies the scheduling rules from the schedule generation
profile. So that the process applies these rules correctly, it now also considers the previous and
next schedules for the affected workers. For example, while checking that the rest period

between work shifts is honored, the process needs to see if the worker was scheduled to work the
day before this schedule period starts. The same is applied while validating workforce schedule.

• The same enhancement applies to workforce schedule validation.

Details
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SCHEDULE VALIDATION REPORT

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

This feature helps schedule managers more efficiently 

publish workforce schedules that comply with 

organizational policies and regulatory requirements.

Business Benefit:

You can now validate the schedule for a given department, location and scheduling period directly 

from the workforce schedule page. On the Job view, select More Actions > Validate Schedule. The 
schedule validation process checks the schedule against these items:

➢ Scheduling rules configured on the schedule generation profile

➢ Workers' work patterns
➢ Overlapping shifts

➢ Approved or pending approval absences
➢ Assignments for the department
➢ Overstaffing and understaffing coverage variances



Presentation Title  |  Author  |  Date 47Company Confidential © Mastek 2023. All rights reserved  |

WORKFORCE SCHEDULE ENHANCEMENTS

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

• You can now filter workforce schedules to show only schedules with periods that start and end

during the specified date range. You can now see the Published By and Published Date columns
and sort the schedules by these values.

Details
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WORKFORCE SCHEDULE ENHANCEMENTS CONT..

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

On the schedule pages, you can now filter shifts by category, shift, and shift type. You can also
search for shifts for specific worker or job name. When you switch between Job and Worker views,
the current search criteria are applied. For example, if I search for RN shifts on the Worker view

and then switch to the Job view, I see only RN shifts.

Details
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WORKFORCE SCHEDULE ENHANCEMENTS CONT..

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

When you're in the Worker view, you can also use the More Actions to show or hide workers with
no shifts. The workers with no shifts always show after the open and assigned shifts.

Details
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WORKFORCE SCHEDULE ENHANCEMENTS CONT..

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

You can also now edit open shift groups and either increment or decrement the number of shifts,
or change shift properties. And the new Allow Overtime switch lets workers who've reached their
FTE be assigned the shift without causing business validation issues.

Details
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WORKFORCE SCHEDULE ENHANCEMENTS CONT..

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

Shifts with day start times that fall on the previous or next day are marked on the calendar day
with an * (asterisk)..

Details



Presentation Title  |  Author  |  Date 52Company Confidential © Mastek 2023. All rights reserved  |

WORKFORCE SCHEDULE ENHANCEMENTS CONT..

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

These enhancements let schedulers 

more efficiently manage their 

schedules.

Business Benefit:

Public holidays defined for locations and using geographical trees now appear on workforce
schedules, as do pending and approved absences. Shifts with swap, drop, and cover requests also
now appear on the schedule. You can access pending approval details from the shift details drawer.

Details
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NEW SUBJECT AREA - SCHEDULE GENERATION PROFILE 
SETUP REAL TIME

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

This feature lets you Report on various 

details associated to the schedule 

generation profiles that are setup.

Business Benefit:

Details

• You can now use the subject area Workforce Scheduling - Schedule Generation Profile Setup Real Time to
report on various details associated to the schedule generation profiles that are setup. The details

include name, code, active start and end dates, description, schedule periods, including weeks in the
schedule cycle, the day start time for the staffing departments, and the 2 consecutive days marked as

the weekend.
• You can also report on Schedule managers, Staffing departments, the jobs and positions filter, various

scheduling rules that are setup, the operating shifts and so on.
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THE ENHANCEMENTS TO THE TWO SUBJECT AREAS ARE 
SUMMARIZED AS BELOW.

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

This feature provides enhancement on 

metioned subject area to improve 

reporting capabilitues of the module.

Business Benefit:

Details

The enhancements to the two subject areas are summarized as below.
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NEW SUBJECT AREA FOR SCHEDULING - SCHEDULE 
COVERAGE REAL TIME

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration NO

Quick Win YES

Workforce Scheduling

This subject area is necessary to drive 

the organization's preparedness for 

scheduling gaps and surpluses for 

upcoming schedules.

Business Benefit:

Details
You can now use the subject area Workforce Scheduling - Schedule Coverage Real Time to view real time

information on schedule coverage. This subject area provides information to ensure proper staffing
coverage for each shift. Schedule Coverage Variance provides the difference between the Workload
requirement and the actual amount scheduled.



DEFAULT WITH CONFIGURATION 
CHANGE

NEW FEATURE – WORKFORCE 
SCHEDULING
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WORKER SELF-SCHEDULING: SWAP SHIFT

Impact Level MEDIUM

Impact Analysis

Need to Enable YES

Configuration YES

Quick Win NO

Workforce Scheduling

This feature boosts workforce 

satisfaction and efficiency by enhancing 

scheduling flexibility and accommodating 

changing availability. The result is a more 

agile and contented workforce, 

positively impacting overall operational 

performance.

Business Benefit:

• You can swap your assigned shift with up to three other shifts, as needed. If your request gets declined
and there's still time, you can try again with different shifts. Otherwise, you need to work your original

shift. You can also withdraw each swap shift request separately.
• This feature boosts workforce satisfaction and efficiency by enhancing scheduling flexibility and

accommodating changing availability. The result is a more agile and contented workforce, positively
impacting overall operational performance.

TIPS AND CONSIDERATIONS
• Workers can request shift swaps only if the shift start time is at least 72 hours away. Also, they see only

shift options scheduled during the work week of the original shift. Both of these constraints will be
configurable in a future release.

• Managers with area of responsibility for the department associated with the requested shift swap get the

approval notifications.

Details
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SELF-SCHEDULING: APPROVAL CONFIGURATION

Impact Level LOW

Impact Analysis

Need to Enable No

Configuration YES

Quick Win NO

Workforce Scheduling

This feature lets 

workforce schedule 

administrators create 

tailored approval 

workflows that align with 

organizational policies.

Business Benefit:

Details

• You can now configure the approval workflow for drop shift requests, cover requests, and

swap requests so they align with your organization's policies.

• Here's what workforce schedule administrators authorized to manage drop, cover, and swap

shift requests can do:
➢ Use BPM Workflow rules and payload data to manage the approval process.

➢ Customize the default workflow using these available payload attributes.
➢ Test the workflow using the simulation feature.
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Closing

Q&A
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1. What happens next?

1. Presentation

2. Session Recording

2. Speak with your CEMS Support 

Manager or CEMS Service Manager

1. for additional services around 

quarterly updates

2. Learn more about Innovation

3. Next Sessions ?

CLOSING NOTE



This presentation contains information that may be privileged or confidential and 

is the property of Mastek.

Copyright © 2023 Mastek. All rights reserved.

THANK YOU

is here to

help you!

MASTEK

https://www.linkedin.com/company/mastek/
https://twitter.com/Mastekltd
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